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User Manual

Introduction

Macroscopel is a desktop application used for examining crystallization experiment images and data. It
is intended as an upgrade/replacement for HWI’s original MacroScope program. Macroscopel is an
ongoing project which will be improved and extended in future releases.

About this release

While Macroscopel shares much functionality with our earlier program, it is intended to far surpass
MacroScope’s capabilities. In order to make this possible, it was necessary to create a new interface,
change features, and add new features.

The current release aims to supersede MacroScope by providing all existing functionality, while
introducing the new interface of Macroscopel and many of the new tools that have been developed.
Some major changes include:

Cross-platform Java technology

Multiple-document interface

Improved navigation controls

Image thumbnail resizing

e Color-coded scoring

o New tools, such as magnifying glass, crystal measure, and slideshow

Some features are intended to be upgraded or enhanced in future releases. This release operates only in
a “Legacy” mode which mimics existing MacroScope features, such as loading/saving MSO files,
extracting cocktail data from composite lists, and exporting HTML pages. Future versions will also
include a limited-feature Legacy mode; but emphasis will be on developing a new, more comprehensive
data-centric base.

For existing MacroScope users

It is important to keep in mind that Macroscopel is not merely the next release of MacroScope; it is a
new and different program. It contains a completely new code base, written in a different language, and
was designed with a much broader scope of goals in mind. It is therefore, of necessity, a much more
complex application than MacroScope. To become acquainted with the new design and features, take
the time to read the section entitled “Concept overview”.



That being said, much of the program will appear familiar to the veteran MacroScope user. There are
still two essential experiment views: a page of well thumbnails, and a full-size image review window. For
those who score their images, the scores may be toggled using the same 7 numpad keys. There are
again several export options, including the traditional MSO (MacroScope Output) file and HTML web
page. To help you get started, there are tutorials at the end of this document explaining how to perform
some basic tasks that you have probably done before using MacroScope. Other features and tools can
be explored at your leisure.

There are some particulars that should be noted:

e When opening an MSO file, Macroscopel first looks for the required RAR file in the same
directory. If it cannot be found there, the program will ask you to browse for it manually.

e |mage thumbs are arranged, by default, in order of sequential well position #, not cocktail #.
(This can be changed inside the “Visual Elements” tab of the arrangement’s “Tools” panel.)

e Image thumbs also, by default, display the well position #. (This text can be hidden or changed
to display the cocktail # using the “Visual Elements” tab.)

e  “Selecting” an image in Macroscopel is essentially the same as “marking” it in MacroScope,
though it is more flexible because of the options provided throughout the program.

o There are two web page export formats. “HTML Selection List” is the one most similar to
MacroScope’s “Save as web page” feature.

System requirements

e Java-capable OS (officially tested on the following systems, though others may also work:)
o Windows XP

Windows Vista

Windows 7

Mac OS X 10.5 “Leopard”

Mac OS X 10.6 “Snow Leopard”

Ubuntu 9.04 “Jaunty Jackalope”

Ubuntu 10.4 “Lucid Lynx"”

e Java Runtime Environment (JRE) 1.6 or later

e 256 MB of available RAM*

e 1.60 GHz. processor or faster recommendedt
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*256 MB is the default/recommended maximum amount of RAM for the JVM (Java Virtual Machine) in which Macroscopel runs. The default
JVM heap settings (min: 128 MB — max: 256MB) should be sufficient for most users. If you are using a powerful machine with lots of RAM, you
can change these settings by running MacroscopelJ from a console (terminal or command prompt).

The following example will launch Macroscopel with an initial heap size of 128MB and a maximum of 1024MB:
> java -jar -Xmsl28m -Xmx1024m MacroscopeJ.jar

Tintel Atom @1.60 GHz is the minimum processor that MacroscopelJ has been tested on. You can probably use a slower processor if you want;
of course, Macroscope) will be... well... slower.



Support

Support is provided by the developer. He can be reached at (716)-898-8676 or rnagel@hwi.buffalo.edu.
The best way you can help us to make Macroscopel better for you is providing detailed feedback. If you
receive error messages, or a feature does not behave as expected, please:

send a description of the error and what you were doing when it occurred

provide information about your operating system, Java version, and Macroscopel version
attach screenshot(s) of the problem

be prepared to assist in troubleshooting the problem
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Concept overview

(This section lists some of the important concepts in Macroscopel. It is advised to read this section
before following the tutorials at the end of this document.)

Projects & Legacy Mode

Macroscopel is intended to work with Projects, collections of related files that are stored, opened, and
saved as a complete unit. Projects have been disabled for this release; instead, there is a type of pseudo-
project called “Legacy”. Any open arrangements will be stored in the “Legacy” folder in the “Projects”
tab.

Resources

Resources are external files which are used by Macroscopel, but not loaded into memory; instead, their
locations are manifested so that they can be accessed by the program when required. In this release,
the only type of resource is RAR archives. When a RAR file is loaded, its content is extracted to a
temporary location, and it is displayed as an icon in the “Resources” panel at the left side of the main
window. Henceforth, any arrangement or feature (e.g. history) that requires the contents of the RAR file
will be able to access it.

Right-clicking a resource icon in the “Resources” panel will give the user several options: notably,
“Unload” and “Delete”. The unload option will clean up any temporary files extracted from the resource,
and remove the pointer to the resource file. To use the resource again, it must be reloaded. If an
existing arrangement cannot find a RAR file because it has been unloaded, it will display “Image not
found” instead of the image. (Note that all resources are automatically unloaded when Macroscopel is
exited.) The other option, delete, will literally delete the resource file from disk. It is a convenient
shortcut for removing a local copy of a file that is no longer needed. Use caution, and NEVER SELECT
THIS IF YOUR RESOURCE IS A UNIQUE, ORIGINAL FILE ON YOUR COMPANY’S ARCHIVE SERVER!!!

Arrangements

Arrangements are the features which contain and display the images you work with. In this release, all
arrangements contain, by default, every image from a particular RAR file. Thumbnails are displayed one
page at a time; there are 16 pages, each with 96 images, for a 1536-image RAR file. The currently
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displayed page can be changed with the controls at the top of the arrangement frame. Left-clicking an
image will bring it up in the full-image window. Right-clicking an image will select it within the
arrangement.

Tools

When an arrangement’s frame is active (focused), the “Tools” panel on the right side of the main
window will display tools for manipulating the arrangement. Click the appropriate tab to view/change
options for a particular tool.

Currently available tools include:

o cell (image) sizing
e mouse functions

e selection options
e visual elements

o slideshow

e transform/export

Selection

Images can be selected in the arrangement by right-clicking them. To select a contiguous group of
images, right-click an unselected image and drag over the other images. Deselecting images is
performed the same way, except that you right-click on an already selected image. Options for selecting
can be changed in the “Selection” tab in the “Tools” panel. The selection can also be hidden by
unchecking “Show selection” in the “Visual Elements” tab. An image may also be selected by pressing
the spacebar while in the full-image window.

Selection has a number of uses. It can be used to mark images to be reviewed later, or to specify which
wells should be saved in an MSO file. It can also be used to limit the images used in an operation, such
as viewing a slideshow.

MDI Interface

Macroscopel has been designed with a multiple-document interface, meaning that multiple documents
can be open at once. Thus you can have several arrangements open within Macroscopel, each in a
separate internal window, as opposed to having several instances of the application open
simultaneously. All open documents are shown as icons in the “Projects” panel. (In this release, the only
type of document is arrangement.) Right-clicking a document icon will give the user several options:
show, close, rename, delete. Show will ensure that the document’s window is visible in the main desk
area. Close will close the document’s window (the document will still be in memory). Rename will
change the name of the document. Delete will remove the document from memory. There are several
window operations available for working with open documents; these are available in the “Window >
Arrange” menu, and on the icon bar for convenience.



(Note that all documents are automatically deleted when Macroscopel is exited. Projects are disabled in
this release, which means that documents cannot be saved as such. To save your work, you should
choose one or more export formats from the “Transform” tab in the “Tools” panel: see tutorial #4.)

Full-lImage Window

Left-clicking a thumbnail in an arrangement will show the full-sized image in another window. This
window is most useful for checking images one at a time for crystallization outcomes. Depending on
how the software is used, this may be done by selecting the image or by categorizing it using one or
more “scores”. This window, like the main window, contains a toolbox on the right side; selecting a
tool’s tab will enable that tool (which sometimes uses the mouse) and show options for it. For more
information on using this window, see tutorial #2. For information on using the well history tool, see
tutorial #3.

Memory

As any Java program, Macroscopel runs within its own Java Virtual Machine (JVM). The JVM is set up to
work with a finite allocation of your system’s memory (RAM). The default for Macroscopel is 128MB
(minimum/initial allocation) to 256MB (maximum allocation). The more arrangements (or memory-
intense operations) you have open at one time, the more memory will be used. From time to time, Java
will automatically “collect garbage”, i.e. free up memory which is no longer being used.

In the main icon bar, there is a meter icon that displays a percentage: this is the amount of currently
used memory in relation to the maximum amount available to the JVM. When this percentage
approaches 100%, the application is in danger of crashing. It is the user’s responsibility to monitor this
number and work with only a manageable number of documents at any time. If you find it necessary,
you may increase the amount of memory allocated for the JVM (see the “System Requirements” section
of this documentation for more information).

Clicking the memory icon (or pressing Ctrl+M) will display a memory monitor dialog, which shows a
more detailed analysis of JVM memory usage. You can also click a button to “force garbage collection”.

Launching the application

For Windows users: Run “Macroscopel.exe” (Windows executable)
For Mac users: Run “Macroscopel.app” (Mac application)

For Linux users: Run “Macroscopel” (bash script)

(For some support calls, the user may be instructed to run “MacJLog.bat”, or to start Macroscopel from a
command prompt or terminal. This produces log and error information that can be useful to the
developer to diagnose issues.)



Basic Operation

(This section will guide a new user through using Macroscopel to review and select images of interest, and then to

export the selection as an MSO file. Follow these steps when requesting additional HTS Lab services, such as UV

imaging.)

1. Start Macroscopel.
(See above section on
“Launching the
application”.)

= Macllog.bat
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File
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2. Select “(Legacy)
Open MSO/RAR”
from the “File” menu.

File | Tools Window Help
@ Load Resource(s) ]
BB (Legacy) Open MSORAR...
o Exit
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3. Browse for the
RAR file. The default
filter shows both
RAR and MSO files.
To view only RAR
files, select the
appropriate filter.
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4. The RAR file will be
extracted. Notice that
itis now listed in the
“Resources” panel on
the left. Also, a new
Arrangement has
been automatically
created to show you
the RAR’s images.

5. Left-click the first
image in the
arrangement; this
will create a popup
window showing the
image at full size.

6. If the image looks
interesting, press
spacebar to select it.
This tells the program
that the image should
be exported when the
MSO file is created.
Press = or [Enter] to
move on to the next
image.

7. When you are
finished reviewing
images, close this
window. Go to the last
tab of the main
Toolbox and click the
button to export as
“MSO File”.

Tools
{Arrangement)

=

Export as...

HTML Arrangement
HTML Selection List

8. Browse to the
location where you
want to export the
new MSO file and
click “Save”. On the
following dialog,
leave the default
options checked and
click “OK”.

[_] Include all entries

Include selected entries

Include scored entries




Other Tutorials

(These tutorials do not attempt to cover the full range of current Macroscopel features. If you notice

that a feature or option is not mentioned in this documentation, experiment with it.)

#1: Open a single RAR file to view its images

#2:

Run Macroscopel.

Select “(Legacy) Open MSO/RAR” from the “File” menu.

Browse for the RAR file. The default filter shows both RAR and MSO files. To view only RAR files,
select the appropriate filter.

The RAR file will be extracted. Notice that it is now listed in the “Resources” panel on the left.
Also, a new Arrangement has been automatically created to show you the RAR’s images.
Right-clicking on an image will select it within the arrangement. To select more than one image,
right-click and drag across the images. To deselect, right-click on an already selected image.
You can use the tools in the “Tools” panel to interact with your new arrangement of images.
Change tools by selecting a different tab, and try them out!

By default, the arrangement puts a RAR’s images in 16 pages, each with 96 images. You can use
the drop-down box or arrow buttons at the top of the arrangement window to view other

pages.

Viewing single images full-size in a popup window

1.

Left-click on any image in the arrangement; this will create a popup window showing the image
at full size.

You can navigate to the previous or next image in the arrangement by clicking the arrow buttons
in the “Navigator” frame, or using the left/right arrow keys. Press “Home” to jump to the first
image in the arrangement, or “End” to skip to the last image.

To navigate through only selected images, click the red arrow buttons or press [Ctrl] + [left,
right, home, end].

To optimize the display for small screens (such as netbooks), this window may be automatically
resized. If the well is not properly centered in the “Image” frame, you can use the scroll bars to
position it. The position will remain when you change to other images.

To view cocktail data (composite list entry) for the image, check “Show Composite list data”
from the “File” menu. A new always-on-top window will appear; you can drag this and resize it
as desired. The data will be updated when you change to a different image.

To toggle whether the image is selected in the current arrangement, press the space bar. When
an image is selected, you will see a red flag in the top-right corner of the image.

To score the image, select the “Scoring” tool from the “Toolbox” frame and check the box for
the score you want. You can also press the corresponding number key on your keyboard to
toggle the score. Multiple scores are allowed; note, however, that “clear” is exclusive.

You may exit this window by closing it with the mouse or by pressing the Escape key.



#3: Viewing well history
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First open an MSO or RAR file to produce an arrangement of images (see tutorial #1).

Select “Load Resource(s) = Load RAR File(s)” from the “File” menu.

Browse to locate RARs for the other reads that you want to include in the history view.

Each RAR file is extracted and added to the “Resources” panel on the left.

Left-click an image to open the full-size window.

Select the “History” tab from the “Tools” panel. You will see a thumbnail of the well for each
read, along with a timestamp.

Mouse over the history thumbnails to view the full-size image of the read.

#4:. Exporting an arrangement

1.

In the main window, activate the arrangement you want to export. The “Tools” panel on the
right will display arrangement tools.
Select the last tab, “Transform”.
There are three options available:
a. Exportas MSO File
An MSO file is a plain text file which saves the composite list entries for selected
images/wells. Any scores will also be saved. This is a backwards-compatible file that can
be opened in MacroScope, AutoSherlock, etc.
b. Exportas HTML Arrangement
This option saves a folder containing an HTML version of the arrangement. You can
either save the current page of images, or the entire arrangement with an index + 16
pages. When opened in a browser, you will see the images arranged as in Macroscopel;
left-clicking a thumb will show you the full-sized image (with composite list info) in
another window/tab. You may also choose to “create true thumbnail images”, which
will make the loading time for each page faster when viewing online (at the expense of
storage space).
c. Export as HTML Selection List
This option saves a folder containing an HTML list of the currently selected images.
When viewed in a browser, you will see a table containing image thumbs, composite list
data, and any scores. Left-clicking a thumb will show you the full-sized image (with
composite list info) in another window/tab. You may also choose to “create true
thumbnail images”, which will make the loading time for each page faster when viewing
online (at the expense of storage space).
If you plan to import the scores into Macroscopel (or another program) at a later time, export
an MSO file. If you want to show an entire page, or all pages, in a browser (rather than in
Macroscopel), export an HTML arrangement. If you want to view certain wells in a browser,
possibly online, export an HTML selection list.



Operating system notes

Macroscopel was developed on Microsoft Windows Vista and Windows 7, 64-bit editions. As a PC
running Windows is today’s de facto standard, this documentation has been written with the Windows
user in mind. If you are using a different operating system, the following notes may be useful to you.

Mac OS X:

Linux:

Other:

Every version of Mac OS X comes with Java pre-installed. Earlier versions of Mac OS X come with
Java 5 (J2SE 5.0). You can check your current Java version by typing “java -version” from
Terminal. Macroscopel requires Java 1.6 or later to run. If your current version is not 1.6, open
your “Java Preferences” and set 1.6 as your default (if present). For more information about
Java on Mac OS X, see http://developer.apple.com/java/faq/.

This document assumes that you have a mouse with at least 2 buttons. If you are using an Apple
mouse with only one button, you may be able to simulate a “right-click” by using “Ctrl+click”.

Macroscopel has been tested on 2 versions of Ubuntu, which is by far today’s most popular
Linux distribution. Hopefully it will also run on other distributions without a problem; but no
other distribution has been tested yet.

Running Macroscopel on Linux may require you to install UnRAR separately. If your distribution
uses a package manager (Debian, etc.), it is advised that you use it to install UnRAR. Otherwise,
you may be able to obtain it from the RARLAB website: http://rarlab.com/rar _add.htm

Other operating systems may have Java installed and be able to run Java programs; however, at
this time, they are not supported by Macroscopel. This is because Macroscopel requires the
UnRAR program, which is only included now (along with the respective free license files) for
certain operating systems. If we receive enough requests for another OS, we will consider
extending support for it in a future release.
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